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All activities can be created using a practice Google Sheet. To get the 
copy of the sheet go to rebrand.ly/GoogleSheetPractice 

 

Create a new spreadsheet  
There are three ways to create a Google Doc. 

1.​ Option 1- Sign into your Google Account (SEE PAGE), Go to the 
Google Apps icon (“waffle” shape of 9 dots) next to the Google 
Sign in icon, click on the Google Sheets icon. 

2.​  Option 2- Go to Sheets.Google.com, You can choose a template 

to create a Google Sheet or select the rainbow + to create a 
blank document. 

3.​ Option 3- In the address bar URL type Sheets.new.  

Once you have created a new blank document- Rename the file by 
creating a name in the top left text box next to the sheets icon.  

https://youtu.be/KH41f8T
D0-s  

Converting/Opening Excel Sheets 
1.​ In Drive, find the Excel file. (The logo is a green X.) 
2.​ Double click and the file will open with a black border, and Open 

With will be at the top of the page.  
3.​ Click on the Open With  dropdown menu and select Google 

Sheets.  
4.​ The file will be opened with Google Sheets but will remain in 

https://youtu.be/0b4VI6c0
abM  

http://rebrand.ly/GoogleSheetPractice
https://youtu.be/KH41f8TD0-s
https://youtu.be/KH41f8TD0-s
https://youtu.be/0b4VI6c0abM
https://youtu.be/0b4VI6c0abM


 

Office Excel Format. 

To Convert the file to Google Sheets format - With the Excel file open in 
Google Sheets, go to the file menu and choose Save as Google Sheets.  
Doing so will create a new copy of the file in Google Sheets format. 

 

Basics  

Naming a cell and range  
Google Sheets are created using a series of columns and rows that 
create cells.  A Row is a horizontal set of cells labeled numerically, and a 
Column is a vertical set of cells labeled alphabetically. Cell is a single 
point of data where a column and row intersect.  
 
Each cell in the practice Google Sheet has a name. The cell is named for 
the column letter and then the row number.  A1  
 
Range: A range of cells across a row, a column or both. A range of cells 
is written with the first cell name, separated by a colon, and the final cell.   
A3:A7 
 
 
In the Practice Google Sheet look for a range of cells highlighted yellow, 
and mark them as a range. 

https://youtu.be/ONMD3M
PsEWE  

Adding Text to a Cell  
 
In the Practice Google Sheet click on the top left cell on the sheet (A2) 
to start adding text. Try formatting the text using the features below. 
 
An active cell will have a blue border, Type your name in the cell. When 
you are done entering the data- 

●​ If you press enter you will move down.  
●​ If you press the tab key you will move right.  
●​ Use the arrow keys to move in any direction.  
●​ Click on any cell to jump directly to that cell.  

 
For cells that already have data-  

●​ Clicking the cell ONCE will highlight the entire cell and will replace 

https://youtu.be/VV69Xo_
XpL0  

https://youtu.be/ONMD3MPsEWE
https://youtu.be/ONMD3MPsEWE
https://youtu.be/VV69Xo_XpL0
https://youtu.be/VV69Xo_XpL0


 

the data if you type.  
●​ Clicking the cell TWICE enters into the cell, and allows you to edit 

the data in the cell without replacing it.  
 
Formatting Text  
Similar to a word processor Google Sheets allows you to format the text. 
Using the top toolbar you can change:  
 

●​ Font- Click on the default font style and change the font.  
●​ Font size - select the 10, and choose the size from the drop-down 

menu.  
●​ Bold  
●​ Italic 
●​ Strikethrough 
●​ Font Color 

 
Select the format menu and select clear formatting to clear the text 
format.  
 
To add an “enter” within a cell, use CTRL+ Enter on a pc, or 
COMMAND+Enter on a mac.   

Moving Rows and Columns  
Rows-  
To Highlight all cells in a row- To highlight all cells in a row, click on the 
number to the left to highlight the entire row.  
 
Highlight multiple rows-  Click the number once, and before letting go 
hold the control/command key and select each row by clicking on the 
row number.   
 
To select an entire “list” of cells. Click on the number of the first row, 
hold on the shift key and click the number of the last row.  
 
Move an entire row-  Click on the number heading of the row, hover 
over the row until a hand icon appears. Click and drag the row to the 
desired location and release. Or Highlight the row to move, click on the 
edit menu, select move up or move down.  
 
Delete an entire row- Highlight the entire row, right click, click on 
delete row. OR highlight the entire row, click on the edit menu, select 
delete row.  
 

https://youtu.be/cFRU2e1
FfjI  

https://youtu.be/cFRU2e1FfjI
https://youtu.be/cFRU2e1FfjI


 

Add an entire row - Highlight the row close to the row to highlight, 
right-click, from the menu select insert 1 row above or below.  
 
Change the height of a row  
 
 
Columns-  
To Highlight all cells in a column- To highlight all cells in a row, click on 
the letter heading on top of the column to highlight the entire column.  
 
Highlight multiple columns-  Click the letter heading once, and before 
letting go hold the control/command key and select each column by 
clicking on the column letter.   
 
To select an entire “list” of cells. Click on the letter of the first column, 
hold on the shift key and click the letter of the last column. 
  
Move an entire column- Click on the letter heading of the column, hover 
over the column until a hand icon appears. Click and drag the column 
to the desired location and release. Or Highlight the column to move, click 
on the edit menu, select move right or move left.  
 
Delete an entire column- Highlight the entire column, right click, click 
on delete column. OR highlight the entire column, click on the edit menu, 
select delete column.  
 
Add an entire column- Highlight the Column close to the row to 
highlight, right-click, from the menu select insert 1 column to the left or 
to the right.   
 
Change the width of a column  
 
In the Practice Google Sheet practice moving, adding and deleting rows 
and columns.  

Copying Cell Data  
 
In the Practice Google Sheet practice Sheet, we are going to practice 
copying cells. In the same top left cell type a word.  
 
Make sure the active cell is highlighted with the dark blue border, in the 
bottom right of the activated cell is a blue square.  
 

https://youtu.be/OUlKogxy
kJ4  

https://youtu.be/OUlKogxykJ4
https://youtu.be/OUlKogxykJ4


 

Copy cell data- In the active cell, drag the blue square to a range of cells 
to copy the data to that range of cells.  
 
Creating an ordered list- In the first active cell, type in a word that is part 
of a list. For example weekdays, months, alphabet etc.  When you click 
and drag the blue square it will automatically finish the rest of the list.  
 
If you type a word in front of the numbered list, if you highlight the first two 
options and drag the square it will continue the numbering with the word 
in front.  

Sheets Tab 
Google Sheets consists of small sheets as well as the main spreadsheet. 
The Sheets are named on a tab on the bottom of the full spreadsheet.  
 
Add a sheet-  

1.​ Click on the + symbol on the bottom of the spreadsheet to add a 
new sheet.  

 
Sheet menu- 
Click on the triangle on the new sheet tab to open the sheet menu.  From 
this menu you can  

●​ Delete- Delete the current sheet  
●​ Duplicate- Make a copy of the sheet.  
●​ Copy- Copy the tab to a brand new spreadsheet or an existing 

spreadsheet.  
●​ Rename- rename the sheet  
●​ Change Color- Change the color of the sheet tab- this is a thin 

line on the bottom of the name.  
●​ Protect Sheet- set permissions for specific sheets, where only 

certain people can move and edit data.  
●​ Hide Sheet- This will hide the sheet from the active document, 

however, everyone still has access to the sheet if they go to the 
view menu and select the hidden sheet to view.  

●​ Move right or Move Left  
 
You can move the sheet by dragging it to a different place. In the Practice 
Google Sheet create, name, color and delete a Google Sheet.  

https://youtu.be/KP9IhbT
mmNg  

Formatting Sheet 
In the Practice Google Sheet, go to the Formatting sheet on the spreadsheet.  

https://youtu.be/BYGO0HPUDgE  

https://youtu.be/KP9IhbTmmNg
https://youtu.be/KP9IhbTmmNg
https://youtu.be/BYGO0HPUDgE


 

All of these steps can also be completed using the Format menu in the menu bar.  

Text wrapping  
●​ Overflow-Text is in one cell, but will overflow to adjacent empty 

cells. If you type in the empty cells, the adjacent cell text will 
appear cut off.   

●​ Clip- Text will be cut off inside the width of the cell.  
●​ Wrap Text - Will keep the width of a column, but will extend the 

row to fit the text.  
In the Practice Google Sheet, go to the Formatting sheet and practice 
changing the text wrapping. Change the very first description cell to Text 
Wrapping and change the column width.  

https://youtu.be/G9ONLmr
mqxA  

Cell Text Alignment  
In each cell text can be formatted in three different ways using the tools 
on the top toolbar.  
 

1.​ Highlight the text or row/column to be formatted.  
2.​ Select from the top toolbar the horizontal align, vertical align or 

text rotation icon.  
3.​ Three options will appear as a drop down, select from these 

options-  
●​ Horizontally Align text-  Left, center or right.  
●​ Vertically Align text-  Top, middle or bottom.  
●​ Text Rotation- Tilt up, Title down, stack vertically, rotate up, 

rotate down or create a custom angle.  
 
In the Practice Google Sheet, go to the Formatting sheet and align the 
“animal” column of information to the center and middle of the cell.  

https://youtu.be/3az0R6qx
To4  

Paint Roller  
Copy text formatting from one cell to another cell.  

1.​ Highlight the cell you would like to match the formatting. 
2.​ On the toolbar, click the “paint format’ icon.  
3.​ The cursor will turn into a paint roller to show that the format has 

been copied.  
4.​ Highlight the text you want to apply the format to and the 

formatting will be copied over.  
 
In the Practice Google Sheet, go to the Formatting sheet and highlight 
the first description cell and use the paint format icon to format the rest of 

https://youtu.be/G9ONLmr
mqxA  

https://youtu.be/G9ONLmrmqxA
https://youtu.be/G9ONLmrmqxA
https://youtu.be/3az0R6qxTo4
https://youtu.be/3az0R6qxTo4
https://youtu.be/G9ONLmrmqxA
https://youtu.be/G9ONLmrmqxA


 

the text.  

Cell border  
 

1.​ Highlight the cell or cells you would like to format.  
2.​ In the toolbar select the cell border button, select the style of 

border for the highlighted section.  Note- borders will be formatted 
for the entire selected area.  

3.​ Select the border line color 
4.​ Select the border line style  

 
In the Practice Google Sheet, go to the Formatting sheet and create a 
border around the description as well as the animal information.  

https://youtu.be/quAtU0PJ
Ln4  

Cell fill  
1.​ Highlight the cell or cells you would like to change the background 

color.  
2.​ On the top toolbar click on the fill bucket icon, select the color for 

the fill color. 
3.​ You can also select a custom color from the color menu.  

In the Practice Google Sheet, go to the Formatting sheet and fill the 
animal cells with a different background color.  

https://youtu.be/2p7O2Ir_-
10  

Theme/Alternating Colors  
Google sheets has themed colors for headers, alternating fill colors to 
easily fill all multiple cells at the same time.  

1.​ Highlight the range you would like to format with alternating colors 
(you can adjust the range in the alternating colors menu).  

2.​ Select alternating colors from either the format menu or from the 
color fill icon > alternating colors.  

3.​ An alternating color menu will appear on the right of the screen.  
From this menu-  

●​ Adjust the data range 
●​ Select a different header or footer color 
●​ Select a color pattern from the default color styles or  
●​ Create a custom color pattern of your own. 

An alternative to alternating colors is to select a theme for the sheet. The 
theme will change the colors of not just cells, but also charts, tables and 
cells.   

https://youtu.be/MwvpkDA
7LC8  

https://youtu.be/quAtU0PJLn4
https://youtu.be/quAtU0PJLn4
https://youtu.be/2p7O2Ir_-10
https://youtu.be/2p7O2Ir_-10
https://youtu.be/MwvpkDA7LC8
https://youtu.be/MwvpkDA7LC8


 

1.​ Select the format menu 
2.​ Select theme 
3.​ On the theme menu on the right select an overall theme color 

scheme. The theme will not fully implement unless there are 
charts and graphs. 

In the Practice Google Sheet, go to the Formatting sheet and add 
alternating colors to your sheet.  

Insert Menu  

Insert rows/Columns etc  
From the insert menu, you can add rows, columns and cells. Look at the 
section above to see how to add rows and columns by right clicking.  

1.​ Select the insert menu 
2.​ From the drop-down menu click on adding rows or columns.  

https://youtu.be/N5vHDrD
uhY8  

Insert Form 
You can insert a Form sheet to the already created spreadsheet. Create 
the form questions right in Google Sheets. The Google Form will be linked 
to the Google Sheet and will be housed in the same drive folder.  

 

Insert Image  
You can insert an image into Google Sheets.   

1.​ Click on the cell where you want to insert an image.  
2.​ Select the insert menu, and select insert image.  
3.​ Choose either image over cells or insert image in cell.  

You can add an image by  
●​ Uploading from your computer 
●​ Camera image 
●​ By URL link 
●​ From Google Photos 
●​ Google drive  
●​ Or search right from Google Image search  

 *All Google image search items are labeled for reuse.  
 
In the Practice Google Sheet, go to the Formatting sheet and insert an 
image for each creature on the list in the B column.  

https://youtu.be/_isXP8Ep
Ugk  

https://youtu.be/N5vHDrDuhY8
https://youtu.be/N5vHDrDuhY8
https://youtu.be/_isXP8EpUgk
https://youtu.be/_isXP8EpUgk


 

Insert Link  
Insert a link to another site or file in the Google Sheet.  

1.​ Select the cell to insert the link and type the text to reference.  
2.​ Highlight the reference text.  
3.​ From the insert menu (or the link icon on the toolbar) select insert 

link.  
4.​ Add the website link, and click apply.  
5.​ The link will now be active.  

 

In the Practice Google Sheet, go to the Formatting sheet and insert link 
for one of the creatures to an external site.  

https://youtu.be/3hQP5o5
gB3Q  

Insert Checkboxes  
Insert clickable checkboxes to keep track of information or tasks.  

1.​ Highlight the column or row to insert checkboxes.  
2.​ Select the insert menu. 
3.​ Select checkboxes. Clickable checkboxes will then be added to 

the highlighted cells.  
 
In the Practice Google Sheet, go to the Formatting sheet and insert 
checkboxes in column C next to the creature images.  

https://youtu.be/y4xbpwA_
AgE  

Insert Comments  
Comments can be added to individual cells.  

1.​ Select the cell to leave a comment.  
2.​ From the insert menu select insert comment (or click on the 

comment icon on the toolbar).  
3.​ To send a comment to a specific person, type @ and the person’s 

email.  
4.​ Click on the green comment button, a triangular flag will appear in 

the top right corner of the cell with a comment.  
5.​ Hover over that cell and the comment will appear. Click on the 

Resolve button to clear the comment.  
6.​ To see all comment history for the document, click on the 

comment icon next to the green share button in the top right 
corner of the Google Sheet.  
 

To delete a Comment  

https://youtu.be/2KukJbC
McPk  

https://youtu.be/3hQP5o5gB3Q
https://youtu.be/3hQP5o5gB3Q
https://youtu.be/y4xbpwA_AgE
https://youtu.be/y4xbpwA_AgE
https://youtu.be/2KukJbCMcPk
https://youtu.be/2KukJbCMcPk


 

1.​ Click on the cell until the comment appears.  
2.​ Click the three dots on the top right corner of the comment. 
3.​ Click on delete comment and delete.  

 

Insert Notes- Remove Notes  
You can also leave a note about particular information instead of a 
comment to others.  

1.​ Select the cell to leave a note.  
2.​ From the insert menu select insert note. 
3.​ Type the note in the space provided.  
4.​ Click off of the cell, a black triangular flag will appear in the top 

right corner of the cell with a note.  
5.​ Hover over that cell and the note will appear.  

 
To delete a note 

1.​ Right click on the cell 
2.​ Click on Clear notes or  
3.​ Select clear notes from the edit menu  

https://youtu.be/VMvBza-7
MQM  

Share Permissions  
 
You can invite someone to become an editor on your Sheet, which allows 
people to collaborate on a sheet  in “real-time.”  
 

1.​ In the top right corner of the Google Sheet, select the green Share 
button.  

2.​ Type in the name or email address of the person you would like 
to share the file with.  

a.​ A message option will appear. You can write a message 
that will be sent with the file through email. If you choose 
not to email the file, click the “notify people” option off.  

3.​ Next to the email, select the pencil icon to change sharing 
permissions. There are three main categories.  

●​ View- people can view, but can’t make any changes to the 
file itself, or share the file with others. They can make their 
own copy.  

●​ Comment- People can make comments and suggestions 
in the document, but can’t share the file with others.  

●​ Edit- people can make changes, accept or reject 
suggestions and share the file with others.  

 

https://youtu.be/9WdHW4
8fIE8  
 
 

https://youtu.be/VMvBza-7MQM
https://youtu.be/VMvBza-7MQM
https://youtu.be/9WdHW48fIE8
https://youtu.be/9WdHW48fIE8


 

*To access more settings- select the “Advanced Options” in the bottom 
right corner.  You can prevent editors from changing access and adding 
new people as well as disable the option to download or copy the file 
when shared.  
 

4.​ When you are finished click done.  
 
The shared file will be in the recipient's “shared with me” drive. They can 
open the file and collaborate in real time. The collaborator’s icon will 
appear above the toolbar, the active cell will be outlined in a different 
color.   
 
SHARE USING A SHAREABLE LINK 
If you don’t have a specific person you want to share a file with, or the 
number of people you want to share with is large, share with a shareable 
link. 
 

1.​ In the top right corner of the Google Sheet, select the green Share 
button.  

2.​ A pop up to share with people and groups will appear. Use the 
drop-down arrow to change the setting for the shareable link. (This 
is separate from the “share” button settings.)  

3.​ Select if you want members in your domain (ours is APS)  to edit, 
comment or view the sheet. Remember if you select edit anyone 
can change the document.   

4.​ If you want to share the document outside of the domain, select 
more- you can then make the document accessible to anyone 
with the link, or public on the web. Before clicking on save, be sure 
to change the settings for access to view, edit or comment 
using the blue drop down menu.  

5.​ Select save.  Select the copy link and send that link to anyone 
you want to share the document with.  

Version History  
You can see all the changes that have been made in a Google Sheet over 
time.  

1.​ In the top menu bar select the File menu, Select Version History  
and then See Version History. 

2.​ A new pane will open on the right. You can select different 
versions of the Google Sheet to see any changes that have been 
made.  

3.​ You can either Make a copy of a different version or Restore a 
previous version of the sheet.  

https://youtu.be/YkNZsrYt
5AI  

https://youtu.be/YkNZsrYt5AI
https://youtu.be/YkNZsrYt5AI


 

 

Formatting Sheet 
In the Practice Google Sheet, go to the Filtering Sheet on the spreadsheet.   

This will give you data that can be manipulated and filtered.   

View- Gridlines/Freeze Panes  
1.​ On your computer, open a spreadsheet in Google Sheets. 
2.​ Select a row or column you want to freeze or unfreeze. 
3.​ At the top, click View > Freeze. 
4.​ Select how many rows or columns to freeze. 

Or- select the thicker gray bands in the top right corner of the Google 
Sheet and drag to where you want the freeze panes to go.  

In the Practice Google Sheet, go to the Filtering Sheet on the 
spreadsheet, freeze the top row.  

https://youtu.be/sbxWx70
9DcA  

Conditional Formatting  
Conditional formatting changes the color of a cell depending on the value 
inside the cell.  

1.​ Select the cells you want to apply Conditional formatting to.  
2.​ Click Format and then Conditional formatting. A toolbar will open 

to the right. 
3.​ Create a rule for the conditional formatting.  

a.​ Single color: Under "Format cells if," choose the condition that 
you want to trigger the rule. Under "Formatting style, choose 
what the cell will look like when conditions are met. 

b.​ Color scale: Under "Preview," select the color scale. Then, 
choose a minimum and maximum value, and an optional 
midpoint value. To choose the value category, click the Down 
arrow. 

4.​ Click Done. 
In the Practice Google Sheet, go to the Filtering Sheet on the 

spreadsheet, apply conditional formatting to  one of the percentage 
columns.  

https://youtu.be/DOvAV08
UOZ4  

Sort Data (top bar),  
Sort a Column (sort sheet) 

1.​ Click on the letter of the column you want to sort the sheet by.  
2.​ Next to the letter a drop-down arrow will appear. Click on the 

https://youtu.be/B-jOrCVa
xNs  

https://youtu.be/sbxWx709DcA
https://youtu.be/sbxWx709DcA
https://youtu.be/DOvAV08UOZ4
https://youtu.be/DOvAV08UOZ4
https://youtu.be/B-jOrCVaxNs
https://youtu.be/B-jOrCVaxNs


 

drop-down arrow. 
3.​ Select to either sort the sheet by A to Z, or Z to A.  

(Note: sheets will sort headers unless the headers are frozen).  
 
Sort a range-  

1.​ Highlight the group of cells you’d like to sort 
2.​ Click on the Data menu, select sort range.  
3.​ If you have a header title, select header has a row.  
4.​ Create a sorting order.  
5.​ Then click sort.  

Note: Sorting the range will not sort the entire sheet, only the range 
selected.  

In the Practice Google Sheet, go to the Filtering Sheet on the 
spreadsheet, Sort one of the columns.  

 

Filter Toolbar icon 
1.​ Click on the filter icon on the top toolbar.  
2.​ A filter icon will appear on each heading, click on the column you 

want to filter the sheet by. 
3.​ From the menu select how to filter the data-  

a.​ Filter by color- choose which text or fill color to filter by when 
there is conditional formatting.  

b.​ Filter by condition- choose conditions from the drop-down  
c.​ Filter by values- Data points are already created for each 

column, uncheck or check the box next to the data points to 
view.  

d.​ Click the filter icon to turn the filter off.  
 
Filter a range of data  

1.​ In the top menu select Data.  
2.​ Then select Sort Range.   
3.​ In the Pop-up menu choose the columns or rows you would like to 

sort the data by, you can sort by more than one option.  
In the Practice Google Sheet, go to the Filtering Sheet on the 

spreadsheet, use the filter to filter information.  

https://youtu.be/d-lD_3wo
maM  

Filter Views 
Another way to view just a particular subset of data is to use filter view. 
Filter views are similar to filters but allows you to name and save filters.  
 

1.​ Click Data on the menu bar 

https://youtu.be/R1brX_Q
Nw_w  

https://youtu.be/d-lD_3womaM
https://youtu.be/d-lD_3womaM
https://youtu.be/R1brX_QNw_w
https://youtu.be/R1brX_QNw_w


 

2.​ Select filter views, a new window will open to the right.  
3.​ Select either  

a.​ Create a new filter view - Allows you to create a filter after 
the “filter” view appears. Filter information, then name the 
filter in the top bar, close the filter view (Filter view will have 
a dark border.) 

b.​ Save a filter - Allows you to save a filtered view of the 
sheet. When the data is already filtered.  

4.​ To access saved filters either go to Data > Filter views> and select 
the named filter from the menu or select the drop down on the 
filter icon to reveal the list.  

5.​ Delete a filter view- open the filter view and click on the cog wheel 
and select delete.  

 
In the Practice Google Sheet, go to the Filtering Sheet on the 

spreadsheet, create filter view with one set of data  

Slicer 
Slicers are quick drop down menus to filter data by specific information. 

1.​ Select the data menu > Slicer  
2.​ Select the column to filter data  
3.​ Choose to apply to pivot tables  
4.​ Move the slicer to anywhere on the sheet 
5.​ Use the slicer drop-down to filter the data quickly  

In the Practice Google Sheet, go to the Filtering Sheet on the 
spreadsheet, create a slicer using one of the column data sets.  

https://youtu.be/sFD6hS0
AmjU  

Google Sheets Pivot Table  
Pivot tables are used to narrow down data sets.  

1.​ Select the cells of data you want to include on a pivot table.  
2.​ Select the Data menu and click on Pivot table.  
3.​ A new sheet will be created. On the right menu panel, select the 

rows and columns, click add and choose the values and how they 
should be displayed (list, sort, summarize, filter).  
 

Note: There are recommended pivot tables at the top of the menu.  
In the Practice Google Sheet, go to the Filtering Sheet on the 

spreadsheet, create a pivot table.  

https://youtu.be/Ei0yyWvi
Qbw  

Data Validation  
Data validation creates drop-downs or interactive icons in the 

https://youtu.be/54ifBwsY
TLs  

https://youtu.be/sFD6hS0AmjU
https://youtu.be/sFD6hS0AmjU
https://youtu.be/Ei0yyWviQbw
https://youtu.be/Ei0yyWviQbw
https://youtu.be/54ifBwsYTLs
https://youtu.be/54ifBwsYTLs


 

spreadsheet cells.  
1.​ Select the data menu 
2.​ Select on data validation  

You are able to create a  
●​ List from a range - create a drop-down list from a range.  
●​ List of items- create a drop-down from a list of items.  
●​ Number- create a drop-down of a number range.  
●​ Text- allows only specific text to be inputted into a cell (ie a 

URL)  
●​ Date- creates a date range  
●​ Custom formulas 
●​ Checkboxes- interactive checkboxes  

3.​ Input data and select save. You can copy the data validation 
across multiple cells.  

 
In the Practice Google Sheet, go to the Filtering Sheet on the 
spreadsheet, create a List of Items for a quick drop-down menu.  

Data Toolbar  
From the data toolbar you will be able to-  

●​ Sort Sheets by data sets.  
●​ Sort selected range of data.  
●​ Turn off filters and filter views  
●​ Data validation- Create properties for cells.  (See data 

validation section)  
●​ Pivot table- create a table of specific data points that can be 

toggled off and on (See Pivot table section)  
●​ Name range- give a specific name to a range of cells to make 

formulas easier.  
●​ Protected sheets and ranges- set permissions for a range of 

cells or a specific sheet.  
●​ Remove duplicates- remove duplicate data.  
●​ Trim whitespace-  
●​ Group data- Group cells to be collapsed 

 
In the Practice Google Sheet, go to the Filtering Sheet on the 
spreadsheet, create a named range or protect different sheets.  

https://youtu.be/Vn8kW2Q
sgyU  

Functions/Formulas Sheet 
In the Practice Google Sheet, go to the functions sheet on the spreadsheet.   

This will give you data you can use to create formulas and functions   

https://youtu.be/Vn8kW2QsgyU
https://youtu.be/Vn8kW2QsgyU


 

What are functions and formulas?  
Formula- A formula is used to perform a calculation such as adding, 
subtracting, multiplying and dividing.  
 
Mathematical operators-  Add (+), Subtract (-), Multiply (*) Divide (/)  
 
Function- A function is a predefined formula that performs calculations 
using a value in a particular order. Functions are created using a key 
function tag before adding cell references. (ie sum, average, count if etc)  
 
Cell reference- creating a formula or function using a particular range or 
cell address to pull in the data. This way if data inside a cell changes, the 
formula will automatically recalculate.  

 

Format Number  
To make formulas and functions calculate easier make sure to format 
numbers. Numbers can be formatted in a variety of ways. Format 
numbers using the Format menu or using the toolbar.  

1.​ Highlight the cells to format 
2.​ Click on the format menu > select number and choose how to 

format the text  
●​ Number 
●​ Percentage 
●​ Scientific  
●​ Money 
●​ Date  
●​ Time 
●​ Decimals  

(there are more subcategories available)  
 
*Decimal amounts can also be formatted using the arrow numbers on the 
toolbar.  
 

In the Practice Google Sheet, go to the functions sheet on the 
spreadsheet.   

Format the cells E4:K4 to percentages with no decimals.  

https://youtu.be/pj5Z3l5Ol
T4  

Create a Formula  
1.​ Select the cell that will display the calculated value  
2.​ Type the equal sign (=) to signal a formula  
3.​ Type the cell address (or select the cell) you want to reference. 

https://youtu.be/5yQqGHK
uH-4  

https://youtu.be/pj5Z3l5OlT4
https://youtu.be/pj5Z3l5OlT4
https://youtu.be/5yQqGHKuH-4
https://youtu.be/5yQqGHKuH-4


 

That cell will have a dotted border with a specific color.  
4.​ Type in the Mathematical operator. (+, -, *, /)  
5.​ Type the cell address (or select the cell) of the second cell you 

want to reference.  
6.​ Press enter and the formula will calculate and display the result in 

the cell.  (To view the formula look at the formula bar on the top of 
the sheet).  

In the Practice Google Sheet, go to the functions sheet on the 
spreadsheet.   

Underneath the student data practice creating a formula by creating two 
reference cells as well as using mathematical operators.  

 

Creating a Function 
A function has three main parts = (equal sign) Function name (ie SUM) 
and argument which is usually part of a range (A1:A20). Arguments are 
always written within parentheses.  =SUM(A1:A20)  

1.​ Select the cell that will display the calculated value.  
2.​ Type the equal sign (=) to signal a function creation.  
3.​ Type in the function name (Sum, average, max etc) 
4.​ Type open parentheses (    
5.​ Select the range of cells to include in the function A1:A20 
6.​ Type closed parentheses )  
7.​ Press enter  

 
In the Practice Google Sheet, go to the functions sheet on the 

spreadsheet.   
Find the average for all the student grades  on the data sheet.  

https://youtu.be/wPdDtDX
Zli4  

Copying Cells with Functions  
You do not need to create a new formula for each row of a Google Sheet, 
Create a single formula in the top cell, and drag the formula down. This 
will create a relative reference- this means Google Sheets will 
automatically change the cell reference for each formula.  
 

1.​ Select the cell that will contain the formula or function.  
2.​ Type in the Formula or function using the range of data as a cell 

reference.  
3.​ Select the blue dot on the bottom right of the calculated cell, drag 

the handle over the cells you want to add the formula/function to.  
4.​ Double click the filled cells to check their formulas for accuracy.  

 

https://youtu.be/pWkEd22I
Gig  

https://youtu.be/wPdDtDXZli4
https://youtu.be/wPdDtDXZli4
https://youtu.be/pWkEd22IGig
https://youtu.be/pWkEd22IGig


 

In the Practice Google Sheet, go to the functions sheet on the 
spreadsheet.  Drag the average formula cell down the column to 
automatically calculate the average for each student.  

Creating Absolute cell references  
There may be times you do not want a cell reference to automatically 
change when you copy a filling cell. You can use an absolute reference to 
keep the same row or column in a formula.  
 
An absolute reference is kept the same with a dollar sign.  
$A$1- The column and row won’t change when copied 
A$1- The row will note change when copied 
$A1- The column does not change when copied  
 
In the Practice Google Sheet, go to the functions sheet on the 
spreadsheet.   
 
After calculating the averages on the practice sheet, a general number 
will be determined based on the percentage grade. The formula uses a 
Vlookup function which states- Look up the score in the previous cell, if 
the percentage is within a specific range on a chart, assign the cell a 
number (1-4).    The function in column M uses an absolute reference in 
order to keep referencing the same cells in the chart for the VLookup 
function.  
 
Look at the functions in columns M, U and AS to see how the functions 
were created. 
 

https://youtu.be/iLW6nn1
M4j8  

Insert chart  
1.​ Select the cells you want to include in your chart.  
2.​ Click the insert chart menu  
3.​ Sheets will take that data and insert a chart. On the right of the 

screen a chart editor will appear. From the editor you can  
Change Setup  
Change chart type  
Update data ranges  
Change data series  
Customize  
Chart style 
Chart & Axis titles 
Series 

https://youtu.be/ZKR_WY
Fjpr8  

https://youtu.be/iLW6nn1M4j8
https://youtu.be/iLW6nn1M4j8
https://youtu.be/ZKR_WYFjpr8
https://youtu.be/ZKR_WYFjpr8


 

Legend 
Horizontal axis  
Vertical axis 
Gridlines  
 

To change the overall colors for the chart- select the format menu > 
Theme >  and on the right select the theme colors.  
 
You can drag a chart to anywhere on the sheet or click on the three dots 
in the right top corner (more menu) and move the chart to a solitary sheet. 
You can also delete or publish the chart through the more menu.   
 
In the Practice Google Sheet, go to the functions sheet on the 
spreadsheet.  Select different data  and practice creating charts.  

Google Sheets Explore Tool  
Use the Explore feature to ask questions about the data in your 
spreadsheet in Google Sheets. You can also see suggestions based on 
your data for formatting along with charts and analysis. 

1.​ First select the area of the graph you would like to be analyzed.  
2.​ In the bottom right corner of Google Sheets select the green 

Explore tool icon.  
3.​ In the new window pane there will be suggestions of charts and 

graphs for the data.  You can also ask questions about the data to 
generate visual representations.  
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